
 Football Pooler Help Index

The Football Pooler manages football pools that are commonly organized during the football season.    It 
greatly aids keeping track of may players and their picks.    With Football Pooler, you can conveniently and
easily enter the picks for many players.    Then, when the games are scored, all players' totals for that 
week will be updated automatically.    Also, at any time, every player's status can be viewed and reports 
on the standings can be generated.

Commands
File menu
Edit menu
Games menu
Options menu
Window menu
Help menu

How to...
Create a new pool
Add a new player
Customize the pool
Run a pool
Run on a network

Registering
Registering Your Copy

For a description of the main window, see Main Window



Registering Your Copy

To register your copy of the football pooler, send your name, address, and version number of the program
along with a check or money order for $10.00 to the following address:
Bruce M. Terry Jr.
111 Oakwood Village Apt. 1
Flanders, NJ 07836

When you register, you will receive a complete working copy of the latest version of the Football Pooler 
(specify disk format if other than 5¼").    Your registered copy will include unlimited site usage of the 
Football Pooler for no additional cost per workstation.



Main Window

The main window of the Football Pooler displays the current standings in the football pooler.    It consists 
of a display of the current week, the main list of players, and three options for sorting the list.

Week
This field displays the current week in the season.    It is for information only.

Sorting options...
Sort by Name
Checking this radio button causes the list of players to be sorted alphabetically by name.

Sort by Previous
Checking this radio button causes the list of players to be sorted by the total number of correct 
picks in the previous week.

Sort by Total
Checking this radio button causes the list of players to be sorted by the total number of correct 
picks for the entire season.

List columns
Player Name
This column contains the names of all the players.

Picks
If any picks have been entered, this column will be displayed.    Otherwise, it will remain hidden.    
It contains an X next to all players that have had their picks entered for the current week.

Week
This column will display the current week of the player in the list.    If all players have been kept 
up-to-date (i.e. their current week is the same as the season's current week) or there are weekly 
winners, this column will not be displayed.

Previous
This column displays the total number of correct picks for the previous week (or week just 
finished).

Total
This column displays the total number of correct picks for the entire season.

Percent
This column displays the percentage calculation of the total number of correct picks out of the 
total number of games for the season.



File menu commands

The File menu contains commands designed to work with databases of football pools.    It offers the 
following commands:

New Creates a new football pool.
Open Opens an existing football pool.
Save Saves an opened football pool using the same file name.
Save As Saves an opened football pool to a specified file name.
Print Prints the standings for the current week.
Print Preview Displays the standings on the screen as they would appear printed.
Print Setup Selects a printer and printer connection.
Export Export the current standings to a tab or comma-delimited file.
Start New 
Year

Erase all current standings and start a new year.

Exit Exits Football Pooler.



Edit menu commands

The Edit menu contains commands designed to modify a player in the current pool of players.    It offers 
the following commands:

New Player Add a new player to the pool.
Modify Player Modify an existing player in the pool.
Delete Player Delete a player from the pool.
Enter Picks Enter the picks for the currently selected player.



Games menu commands

The Games menu contains commands designed to work with a particular week in the season.    It offers 
the following commands:

Schedule Enter the game schedule for the next week.
Scores Enter the scores for the past week.

Print Pick Sheet Print a pick sheet based on the current week.

Print Picks Print a report of all of the player picks for the current week.

Options menu commands

The Options menu contains commands designed to change display options in Football Pooler.    It offers 
the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Settings Change the settings of the current football pool.
Password Change the password for the current account.
Font Change the font used by report titles or report bodies.

Help menu commands

The Help menu contains commands designed to work with the Windows help engine to provide you with 
assistance with Football Pooler.    It offers the following commands: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version information about the Football Pooler.



Settings menu command (Options menu)

Use this command to bring up the Settings dialog box.    This will allow you to customize the current 
football pool to the way you run your pool



Password menu command (Options menu)

Use this command to bring up the Change Password dialog box.    This will allow you to change the 
password for the account you are currently using.



Font menu commands (Options menu)

The Font menu in the Options menu contains commands designed to change the font used in reports in 
Football Pooler.    It offers the following commands:

Print Title Change the font used in the title of all reports.
Print Body Change the font used in the body of all reports.

New command (File menu)

Use this command to create a new pool of players in Football Pooler.    You can open an existing 
document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing pool of players.    You can create new pool of players with the New 
command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
Football Pooler files are listed as "Pool Files (*.fbl)"

Drives
Select the drive in which Football Pooler stores the file that you want to open. 

Directories
Select the directory in which Football Pooler stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the active pool of players to its current name and directory.    When you save a
document for the first time, Football Pooler displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active pool of players.    Football Pooler displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a pool of players with a different name.    A filename can contain up to 
eight characters and an extension of up to three characters.    Football Pooler adds the extension you 
specify in the Save File As Type box.

Drives
Select the drive in which you want to store the file.

Directories
Select the directory in which you want to store the file.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four pools you 
closed.    Choose the number that corresponds with the pool you want to open.



Export command (File menu)

Use this command to export the current standings to a tab or comma-delimited file.    You will be prompted
to enter a file name to which the standings are exported.    You can then import these standings into a 
spreadsheet or database program.



Start New Year command (File menu)

Use this command to erase the current standings and start a new year.    When you do this, all player 
standings will be erased and the week will be reset to zero.    All player names and passwords will remain 
intact.    The reset standings will not be saved unless you save the standings before exiting.



Exit command (File menu)

Use this command to end your Football Pooler session.    You can also use the Close command on the 
application Control menu.    Football Pooler prompts you to save pools with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



New Player command (Edit menu)

Use this command to add a new player to the current pool of players.    When you choose this command, 
you will be prompted with a dialog box for entering the new player's name.

Shortcuts

Toolbar:
Keys: CTRL+E or

See Also
New Player dialog box



Modify Player command (Edit menu)

Use this command to modify the currently selected player in the pool of players.    When you choose this 
command, you will be prompted with a dialog box for modifying the history of correct picks for each week 
in the season.    This command is unavailable if there is no player currently selected.

Shortcuts
Mouse: Double-click the player to modify with the CTRL key depressed or
Keys: CTRL+E

See Also
Modify Player dialog box



Delete Player command (Edit menu)

Use this command to remove the currently selected player from the pool of players.    This command is 
unavailable if there is no player currently selected.

Shortcuts

Toolbar:
Keys: Del



Enter Picks (Edit menu)

Use this command to enter picks for the currently selected player in the pool of players.    This command 
is unavailable if there is no player currently selected.

Shortcuts

Toolbar:
Mouse: Double-click the player whose picks are to be entered or
Keys: CTRL+K

See Also
Enter Picks dialog box



Schedule command (Games menu)

Use this command to enter the schedule for the coming week.    This command is unavailable if there is a 
previous schedule that has not yet been scored.

See Also
Football Schedule dialog box



Scores command (Games menu)

Use this command to enter the scores for the completed week.    This command is unavailable if there is 
no schedule for the current week.

Shortcuts

Toolbar:

See Also
This Week's Scores dialog box



Print Pick Sheet command (Games menu)

Use this command to print a picks sheet for the players based on the schedule for the coming week.    
This command is unavailable if there is no schedule.



Print Picks command (Games menu)

Use this command to print a report of the picks made by all of the players.    This command is unavailable 
if there is no schedule.

The report lists the players on the left and a list of their picks for each game of the week.    The team listed
is an abbreviation of the team they have chosen to win.    See Pick List Abbreviations



Pick List Abbreviations

The following abbreviations are used when printing a list of the players' picks:

Car Arizona Cardinals Rai L.A. Raiders
Fal Atlanta Falcons Ram L.A. Rams
Bil Buffalo Bills Dol Miami Dolphins
Pan Carolina Panthers Vik Minnesota Vikings
Bea Chicago Bears Pat New England Patriots
Ben Cincinnati Bengals Sai New Orleans Saints
Brw Cleveland Browns Gia New York Giants
Cow Dallas Cowboys Jet New York Jets
Brc Denver Broncos Eag Philadelphia Eagles
Lio Detroit Lions Ste Pittsburgh Steelers
Pac Green Bay Packers Cha San Diego Chargers
Oil Houston Oilers 49r San Francisco 49ers
Col Indianapolis Colts Sea Seattle Seahawks
Jag Jacksonville Jaguars Buc Tampa Bay buccaneers
Chf Kansas City Chiefs Red Washington Redskins



Toolbar command (Options menu)

Use this command to display and hide the Toolbar. A check mark appears next to the menu item when the
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Football Pooler,

To hide or display the Toolbar, choose Toolbar from the Options menu (ALT, O, T).

Click To

Open a new document.

Open an existing document.    Football Pooler displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, Football Pooler displays the Save As dialog box.

Add a new player to the pool of players.

Delete the selected player from the pool of players.

Enter picks for the selected player.

Enter scores for the completed week's games.

Print the standings for the current week.

Display copyright and version information about Football Pooler.



Status Bar command (Options menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Football Pooler window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Football Pooler and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Football Pooler.

Shortcut

Toolbar:



Context Help command 

Use the Context Help command to obtain help on some portion of Football Pooler.    When you choose the
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Football Pooler window, such as another Toolbar button.    The Help topic will be shown
for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

Football Pooler -(Name of Pool)

The title bar is located along the top of a window.    It contains the name of the application and currently-
opened pool of players.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right edge of the list of players window.    The scroll box inside the scroll bar indicates 
your vertical location in the list.    You can use the mouse to scroll to other parts of the list.    This list 
appears only if the number of players is too high to display entirely within the list window.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Football Pooler window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Football Pooler window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

The Choose Font dialog allows you to select a font used in the body or title of printed reports.    The 
following options allow you to specify the name, style, and size of the font you're about to choose:
Font

Type a font face name or choose one from the list below.    A sample font with the face name you 
choose will be displayed in the sample box in the lower-right corner.

Font Style
Type a font style or select one from the list below.

Size
Type a point size for the font or choose one from the list below.    Some fonts will not display properly 
if you choose too large or too small of a size.    Others, notably TrueType fonts, will scale nicely no 
matter what size you choose.

Sample
This box shows sample text printed with the currently selected font face name, style, and size.



Football Schedule dialog box

This dialog box is used for entering the current week's schedule.    The games, numbered 1 to 15, are 
listed vertically.    The visiting team is in the left column; the home team is in the right column.    To specify 
the teams for a particular game, move to the combo box for the visitor or home team and select a team 
from the list of 30 teams.    As a shortcut, press the first letter of the team you have chosen until it 
appears.    Usually, the team will be selected after only one or two keystrokes.

If there are less than 15 games for a particular week, Football Pooler will determine which teams have a 
bye week and confirm this with you.    When you are finished entering the games for the week, press OK 
to accept the schedule or Cancel to abort it.

Click on the "Instructions" button to bring up a dialog that will allow you to edit text instructions that will be 
printed at the bottom of printed pick sheets.    You can enter up to six lines of instructions.



Enter Picks dialog box

This dialog box is used for entering the picks for the selected player.    It can only be used for entering 
picks for the current week.

The player whose picks are being entered is listed at the top next to the text "Player's Name:".    Below 
that is a list of the games for the current week in two columns.    It consists of two teams listed to the right 
of a pair of radio buttons with the home team being on the bottom.    To enter the player's picks, select one
of the radio buttons for each game; or, you can click on the "Random" button to have the computer 
generate a random pick for each game.    (This is useful when you are running a season-long pool and 
have players who forget to turn in their picks.)    When you are finished, press OK to accept the picks or 
Cancel to abort.

To review or modify a player's picks before entering the scores, open this dialog box again for the player 
whose picks are to be modified.    The previous picks will be pre-selected.    Simply change the picks as 
desired and press OK to accept the picks or Cancel to abort.



This Week's Scores dialog box

This dialog box is used for entering the scores for the completed week.    It can only be used for the 
currently completed week and all scores must be entered at once.

The games for the current week are listed vertically in two columns with the home team at the bottom.    
To the right of each team's name is an edit box for entering teams score for that game.    Enter the score 
for each team and press OK to accept or Cancel to abort.



Modify Player dialog box

This dialog box is used for modifying the internal data stored for each player.    It consists of the following 
editable fields:

Player's Name
This is the name of the player.    It can be up to 30 characters in length.

Current Week
This is the current week of the player.    It can be from 1 to 20.    However, if you have specified less than 
20 weeks in a season, it will be set to no greater than the number of weeks plus one.

Picks Entered
Check this box to indicate that the player's picks have been entered or clear it to indicate that the player's 
picks have not been entered.

Password
If you have selected password protection in Settings, you can change the password for the new player 
here.

Confirm
If you have changed the player's password, you must re-enter it here to confirm it.    This helps to 
guarantee that you did not misspell anything.

Week 1 - 20
These fields contain the number of correct picks for each week of the season.    These number must be 
from 0 to 15.

When you are finished editing, press OK to accept your changes or Cancel to abort.

WARNING: You should exercise extreme caution when modifying a player's internal data.    Manually 
modifying a player's internal data could result in standings that are inconsistent with fact.



New Player dialog box

This dialog box is used for creating a new player.    It consists of one field:

Name
This is the name of the new player.    It can be up to 30 characters in length.

Password
If you have selected password protection in Settings, you can enter the password for the new player here.

Confirm
If you have entered a password, you must re-enter it here to confirm it.    This helps to guarantee that you 
did not misspell anything.



Inactive Teams dialog box

This dialog box is displayed when the schedule you have entered indicates that two or more teams must 
have a bye week.    In the middle of the dialog box is a list of teams that Football Pooler has determined 
must have a bye.    If more teams have a bye than are visible, a scroll bar will appear at the left of the list 
allowing you to view all of the teams with a bye.

If these are the correct teams with a bye, press OK.    Otherwise, press Cancel.



Players without picks

There are still players in the pool whose picks have not been entered for the week you are about to score.
If you continue, their totals will not be updated.



Unbalanced Schedule

The schedule you have entered has one or more games where only one team was scheduled.    Please 
review the schedule you have entered and correct the imbalance.



Duplicate Team

One or more teams have been entered in two or more games for the same week.    Please review the 
schedule you have entered and remove the duplicates.



Delete Player Confirmation

You have chosen to delete the selected player.    If you wish to confirm this action, press "Yes"; otherwise, 
press "No".



Incomplete Picks

You have not entered picks for every game.    When entering picks for a player, you must choose one 
team from each and every game.    Make sure each pair of teams has one team whose radio button is 
checked.



No Output Device

No output device was detected.    In order for Football Pooler to choose a default font for printing reports, 
a default device (i.e. printer) must have been specified in Control Panel.    You should check the "Printer 
Setup" in Control Panel and make sure a default printer has been specified.    If one has been specified 
and you still receive this message, there may be a problem with your printer driver.    In this case, you 
should try re-installing your printer drivers.



Season Over

The Football Pooler season is over or Football Pooler has tracked the number of weeks you specified in 
the Settings dialog box.    Football Pooler only tracks a maximum of 20 weeks in the season.    You can 
start a new season by creating a new football pool from the File menu.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Administrator    The special user of the Football Pooler that has complete access to the pool of players.   
The administrator can perform any administrative facility, but can not take part in the pool.



Settings

After choosing the Settings menu command, you are prompted with the "Settings" dialog box.    It is used 
to specify the settings for the type of football pool you are going to run.    It consists of seven check boxes 
with four of them being enabled or disabled depending on the status of another check box.

The organization can be seen through the indentation of the check boxes.    If a check box is indented 
from the left, it is enabled only when the check box above and to the right of it is checked.    For more 
information, see the description of the check boxes below.

Password Protection
This check box determines whether or not the Football Pooler implement password protection.    If it is 
checked, players will be assigned passwords and will be able to enter picks only for themselves.    Also, all
other facilities for modifying the current pool (i.e. setting the font or entering the schedule) will be 
restricted to the Administrator.    The password for Administrator will be set after you press "OK".

Use point spreads
This check box determines whether or not the Football Pooler should keep track of point spreads 
assigned to the games.    If it is checked, the Football Schedule dialog box will allow you to assign point 
spreads to the games and printed pick sheets will include these point spreads.    If you choose to use 
point spreads and also choose to print pick sheets with home teams in caps, pick sheets will be printed 
with underdogs always on the bottom with positive point spreads.

Tie counts as win
This check box determines whether or not ties (including games adjusted by point spreads) should be 
counted as wins.    If it is checked, all players will be credited with a correct pick in the event of a tie.

Weekly winners
This check box determines whether or not weekly winners are to be determined.    If it is checked, a 
winner (or winners) will be declared at the end of each week based on who had the most correct picks for 
that week.    Also, if it is checked, the Tie breakers check box will be enabled.

Tie breakers
This check box determines whether or not tie breakers are to be used when determining the weekly 
winner.    If it is checked, the Football Pooler will use one or both of the tie breakers you specify.    These 
tie breakers are chosen by checking one or both of the Monday game or Guess points check boxes that
are enabled if tie breakers are to be determined.

Monday game
This check box determines whether or not the Monday night (or last game in the schedule) is to be used 
as a tie breaker.    If it is checked, the Monday night game will not count in the normal count of correct 
picks unless one or more players are tied.    In the event of a tie, the player or players who correctly guess
the winner of the Monday night game win the tie breaker.

Guess points
This check box determines whether or not point guessing is to be used as an additional tie breaker to the 
Monday game.    If it is checked, the Enter Picks dialog will contain a field for entering the players guess 
of the total points that will be scored in the Monday night game.    In the event of a tie after the Monday 
game tie breaker, the player or players whose guess is closest to the actual score total win the tie 
breaker.

Can not go over
This check box determines whether or not point guessing can go over the actual total.    If it is checked, 
the Guess points tie breaker considers all players in the tie breaker whose guesses are above the actual
total to be losers of the tie breaker.



Print pick sheets with home team in caps
This check box determines whether or not the Football Pooler should print pick sheets with the home 
team in caps.    This allows you to print picks sheets that may seem more familiar to certain players that 
are used to viewing schedules in a newspaper.    If you choose to print pick sheets with home teams in 
caps and also choose to use point spreads, pick sheets will be printed with underdogs always on the 
bottom with positive point spreads.

Number of Weeks
This specifies the number of weeks that will be tracked in the season.    If you wish to track the 17 weeks 
in a season, this should be set to 17.    However, if you want to include the playoffs in your pool in addition
to the regular season, you can set this value to up to 20 to include an additional 3 weeks of games.



Instructions

The "Instructions" dialog box is used for entering optional textual instructions that will be printed at the 
bottom of pick sheets when you print them for your players.    You can enter any text information you wish. 
For example, you may type something like this:

Circle the name of the team you think will win in each game.
The home team is on the bottom.
When you are finished, return this form to the pool manager.

To enter instructions, you first must be at the Football Schedule dialog box.    When you are looking at this 
dialog box, click on the "Instructions..." button.



Change Password

The "Change Password" dialog box is used to enter a new password that will be required to access the 
user account you are currently using.    If, after entering a new password, you save the changes to the 
current football pool, this password will be required the next time you try to log on.



Football Pooler Logon

The "Football Pooler Logon" dialog box is used to specify which account you wish to use to access the 
football pool.    You can choose the Administrator to perform administrative tasks like entering the 
schedule or entering the scores.    Or, you can choose one of the players in the pool to enter your picks.    
Either way, you must then enter the password for the name you choose.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that the Football Pooler is sending output to
the printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

Help for this topic is not available.



Create a new pool

To create a new pool, choose the File New command.    This will create an entirely new football pool with 
new players and new standings.    When you do this, you will be prompted with the Settings dialog box.    
This will allow you to customize the operation of your new pool.

Once the new pool is created, you will have to add a new player to begin entering a schedule and 
entering picks.    Of course, you will probably enter more than one, but one is all you need.    After you 
have entered all of the players, you should save them using the save command.    The new name you 
give the pool will be used to refer to this pool all times in the future when use use the open command.



Add a new player

To add a new player to the pool, you must use the new player command.    This will prompt you with the 
New Player dialog box.    In this dialog box, you must at least enter the player's name (this name must be 
unique in the pool).    If you have specified that you wish to use password protection in the Settings dialog 
box., then you can also enter the new player's password.    They will be required to type this password in 
Football Pooler Logon the next time they access the pool themselves.

Generally, you will not want to enter players after the season has begun.    You can, however, enter them 
and then use the modify player command to bring the player up-to-date by changing the player's current 
week (be sure that the week you specify is equal to one of the other player's current week).    Also, if you 
know that the player had valid picks but was just not available when the pool began, you can manually 
enter the correct number of picks in each of the corresponding weeks



Customize the pool

One of the features of the Football Pooler is the ability to customize the way in which pools are managed. 
When you use the settings command or create a new file, you are prompted with the settings dialog box.   
This allows you to for example specify whether or not you want to use point spreads, if and/or how you 
want to use tie breakers, and how you want your picks sheets to work.

Another way you can customize the Football Pooler is to choose different fonts for the titles and bodies of 
printed reports.    By default, the Football Pooler uses the default font of whatever printer is currently 
specified.    By using the font command, you can specify the font(s) used in the titles and bodies of printed
reports.    You should not pick a large font to use in the body of printed reports as some reports (i.e. "Picks
for Week n") may not fit.    Usually a 10 or 12 point font works best.

The customizations you specify are specific to the current pool.    These settings will not affect other 
pools.    You will have to go through the customization process for all other pools you create.    Also, it is 
not a good idea to change settings in the middle of the season as this may affect how correct picks are 
determined making the end-year total inconsistent with the pool's settings.



Running a pool

Using the Football Pooler to run a pool is simple.    Once you have created a new pool, specified the 
customized settings, and added players, you are ready to begin running the pool.

Running a pool can be thought of as working on a week-to-week basis.    A week begins with the creation 
of a new schedule using the schedule command.    This allows you to enter all of the games for the 
current week.    Once this is done, player's picks can be entered with the enter picks command.    You can 
also first generate a pick sheet using the print picks sheet command.    You should make sure that every 
players has picks entered before entering the scores.    If not, and you are running a season-long pool, 
they will be dropped from pool and you will be required to manually edit their statistics using the modify 
player command in order to bring them back in the pool.

After everyone's picks have been entered and the current week's games are completed, it is then time to 
enter the scores for the current week using the scores command.    After you enter the scores, the players 
totals will be updated and the week will be completed.    Also, if you are running a weekly pool, one or 
more winners will be declared.    If you are using tie breakers in a weekly pool and have chosen to use the
Monday night game as a tie breaker, you can enter the scores before Monday's game.    If no tie breaker 
is needed, a winner will be declared and the week will be completed.    Otherwise, you will be notified that 
two or more players are tied and the tie breaker must be used before a winner can be declared.

See also
Creating a new pool
Adding a new player
Customizing the pool



Running on a network

The Football Pooler was designed to permit multiple, non-simultaneous access to pool files.    That is, 
multiple people can access a pool file across a network, but only one at a time may modify it.    Also, to 
ensure integrity of the file and to prevent other players from cheating by looking at another player's picks, 
you can use password protection.

When you use password protection, each player in the pool is assigned a password that they can change 
at any time.    Then, whenever the pool is accessed, the person accessing the pool must first logon.    At 
this point, the person either chooses one of the names in the player list or chooses the special 
administrator account.    If the person chooses one of the players in the list, they can enter and view picks 
for only that player.    They can not access any other player's picks or do anything other than save their 
picks.    If the person chooses the administrator account, they can perform all functions available.    
Generally, only one person should be given this privilege.

See also
Customizing the pool
Football Pooler Logon




